Getting Started with Elevate

© 2007 Peters Research Ltd. All rights reserved.

The content of this publication is subject to change without notice.

No part of this document may be reproduced or transmitted in any form or by any means, for any purpose, without the written consent of Peters Research Ltd. If, however, your only means of access is electronic, you are licensed to make as many copies as are required for you to make full use of the Elevate software.

Elevate is a trademark of Peters Research Ltd. Microsoft, Windows, Word, Excel and Visual C++ are either registered trademarks or trademarks of the Microsoft Corporation. All other products and company names mentioned herein may be trademarks of their respective owners.

This product contains Formula One from Visual Components, Inc. © 1994-1996.

The Elevate installation program requires you to agree to a Licence Agreement before Elevate is installed. A copy of this Licence Agreement can also be viewed by following the hyperlink on our support web pages. Please select Elevate on the web from the Help menu, while connected to the Internet.

Peters Research Ltd gratefully acknowledges:

Dr Gina Barney for assistance in the implementation of Group Collective Down Peak, ETA and Destination Dispatch (ACA) algorithms. And for defining requirements for the Barney traffic templates.

Dr Bruce Powell for defining the requirements of the Powell traffic templates.

Dr Marja-Liisa Siikonen for defining the requirements of the Siikonen traffic templates.

Document last updated: 01 February 2007
Contents

GETTING STARTED WITH ELEVATE 1

CONTENTS 3

1. INTRODUCING ELEVATE 5
   An Overview 5
   Examples 5
   Versions 5
   Updates 5
   Developer Interface 7

2. START HERE 8
   System Requirements 8
   Installing Elevate 8
   Using Elevate 8

3. TECHNICAL SUPPORT 9
   Getting Help 9
   Your Feedback Counts! 9

4. THE ELEVATE SCREEN 10
   Main Display Area 10
   Accessing Elevate Commands 11
   File Menu 12
   Edit Menu 12
   Analysis Menu 12
   Tools Menu 12
   View Menu 13
   Window Menu 13
   Help Menu 13
   Saving your own default data 13

5. JOB DATA 14
   Entering Job Data 14

6. ANALYSIS DATA 15
   Introduction 15
   Analysis Type 15
   Measurement System 16
   Dispatcher 16
   Interfaces 18
   Time Slice Between Simulation Calculations 19
   No of Time Slices Between Screen Updates 19
   Random number seed for passenger generator 19
   Number of simulations to run for each configuration 19
   Losses 19

7. BUILDING DATA 20
   Introduction 20
   Floor Name 20
   Floor Level and Floor Height 21
   Speed fill table 21
   Express zone 21

8. ELEVATOR DATA 22
   Introduction 22
   STANDARD MODE 22
   Number of Elevators 23
   Capacity 23
   Door Times 23
   Speed, Acceleration and Jerk 24
   Start Delay 25
   Home Floor 25
   ADVANCED MODE 26
   Floors Served 26
   MG shut down and restart time 27
   Max door re-openings 27

9. PASSENGER DATA 28
1. Introducing Elevate

An Overview

Elevate is software used by designers worldwide to select the number, size and speed of elevators for all types of buildings both new and old. Elevate can also be used to demonstrate that modernizing an existing elevator installation can improve service for passengers.

Elevate’s main features.

- Analysis of elevator performance in
  - offices
  - shopping centres
  - mixed use buildings
  - sports and leisure complexes
  - hotels
  - residential buildings
  - airports
  - schools and colleges
  - hospitals
  - car parks
  - public buildings

  This is achieved by techniques ranging from up peak round trip time calculations through to full dynamic simulation.

- Dynamic simulation incorporating a graphical display of elevators responding to passenger calls.
  For your clients, this provides a convincing visual demonstration of your proposals.

- An easy to use Windows interface.
  Enter basic information for a quick analysis or comprehensive data for a detailed model.

- Kinematics calculations are applied to generate accurate elevator speed profiles.

- Fully comprehensive help system and online user support.

- A facility to demonstrate your own dispatcher control system using Elevate Developer Interface. This facility is useful to test and develop dispatcher algorithms.

A more comprehensive list of features of the features included in Elevate is shown overleaf.

Warning! Elevate is an extremely powerful traffic analysis tool. However, it will not make the user an elevator traffic analysis expert. For details of training courses and recommended books, please select Elevate on the web from the Help menu, while connected to the Internet.

Examples

A wide range of examples and case studies are available. Please select Elevate on the web from the Elevate Help menu.

Versions

Depending on the Version of Elevate purchased, different features and functions will be available.

This manual describes the full version of Elevate. For a summary of the features of other versions, please refer to the following table.
# Getting Started with Elevate

## Features

<table>
<thead>
<tr>
<th>Analysis Data</th>
<th>Elevate</th>
<th>Elevate Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up peak analysis - assumes all people arrive at the ground floor, calculates handling capacity and interval</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enhanced up peak analysis - like up peak, but you specify the target handling capacity</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>General analysis - people can arrive at any floor - calculate up peak, two way, basement service and more!</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>General analysis for double deck elevators – all traffic flows, but with double deck elevators</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Simulation - models the whole process of people being transported by the elevators</td>
<td>✓</td>
<td>✓ *</td>
</tr>
<tr>
<td>Selection of control systems including conventional and destination dispatch</td>
<td>✓</td>
<td>✓ *</td>
</tr>
<tr>
<td>Use Elevate to implement, test and demonstrate your own dispatcher algorithms with simulation</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Select Metric or U.S. (imperial) units</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Building Data</th>
<th>Elevate</th>
<th>Elevate Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter floor name and floor level, up to 100 floors served per group</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Express zones</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Elevator Data</th>
<th>Elevate</th>
<th>Elevate Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter number of elevators, maximum 12 per group</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter any capacity or select from standard sizes</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter door times, or allow Elevate to choose automatically based on capacity</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter any speed or select from standard speeds</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter any acceleration and jerk rate or allow Elevate to choose based on speed</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SELECT and SPECIFY features to help you analyse many different configurations in single run</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Report options to automatically reject results that do not meet your criteria</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Option for elevators in a group not to serve the same floors, e.g. basement service by only part of the group</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Option for elevators to be specified individually, e.g. different sizes and speeds in the same group</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Passenger Data</th>
<th>Elevate</th>
<th>Elevate Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter passenger loading and unloading times</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter passenger mass</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter capacity factor</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter length of simulation run</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter stair factor</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enter floor population</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Passengers may arrive at any floor</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Passengers may arrive at ground (lowest) floor only</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Option to mix traffic types, for example passengers, goods, porter with trolley</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Option to change intensity of traffic by time of day</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tools to assist fast entry of common traffic flows</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Option to provide Elevate with a list of passengers, and define each passenger individually</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printed Output</th>
<th>Elevate</th>
<th>Elevate Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary of data entered and results calculated - includes your job titles, company name and logo</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Select toolbar button to transfer the data and results to Excel (if installed on your computer)</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maintenance and support</th>
<th>Elevate</th>
<th>Elevate Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support - telephone, fax and email support included from date of purchase for:</td>
<td>1 year</td>
<td>1 year</td>
</tr>
<tr>
<td>Maintenance - upgrades issued to the software provided at no additional charge, from date of purchase for:</td>
<td>1 year</td>
<td>1 year</td>
</tr>
<tr>
<td>Option to renew maintenance and support with Peters Research Ltd at end of free period</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Option to purchase future upgrades from Elevator World</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Available Formats</th>
<th>Elevate</th>
<th>Elevate Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software and manual available for download from Internet</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Software provided on CD with printed manual</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Activating Elevate</th>
<th>Elevate</th>
<th>Elevate Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you purchase, we provide a key to unlock the software on your computer (plugs into USB port)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>When you have purchased, we provide an unlocking code which unlocks the software on your computer</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

* Indicates for up peak only
Updates
If you have a current maintenance and support agreement with Peters Research Ltd, you will be informed when updates are available.

On the Tools menu, the Update Version option provides a simple way to install intermediate Elevate updates. You are required to enter a Version Number and Password. The latest version of Elevate is downloaded from the Internet and installed automatically.

For this feature to work correctly, you must be connected to the Internet, logged in with administrative rights, and have turned off any firewall preventing applications accessing and downloading files from the Internet. If due to company IT policy you cannot use this feature, Technical Support will provide alternative ways to update Elevate.

Developer Interface
The Elevate Developer Interface provides a way of building your own dispatcher control systems into Elevate.

The Developer Interface requires you to code your control system into a Dynamic Link Library (DLL) using Microsoft Visual C++. A sample project including a basic group control system is provided to get you started (you must own a copy of Microsoft Visual C++ Version 6.0).

When you compile the new DLL, it is placed in the directory where Elevate is installed. Then within Elevate, select the dispatcher from the Custom options in Analysis Data. All of Elevate’s simulation and analysis options are then available to use with your dispatcher.

To access the sample project, please go to the directory where Elevate is installed, and unzip DispatchW.zip.

Please note that assistance with the Developer Interface is not included in the Elevate Maintenance and Support package. Support for the Developer Interface is provided on a consultancy basis. For details of the services available, please go to www.peters-research.com/consult
2. **Start Here**

**System Requirements**
The recommend minimum specification for Elevate is Windows 2000, Pentium 1Ghz with 500 MB RAM. The minimum screen resolution required is 1024 x 768 pixels. Machines with more memory and faster processors significantly enhance the speed of analysis.

**Installing Elevate**
Place the Elevate CD in the CD-ROM drive. Depending on how your computer is configured, the CD may launch automatically. If it does not, press Start, select Run, enter `X:start.exe` (where X is the letter of your CD ROM drive) and press OK. Follow the on-screen instructions to complete the installation.

If you are upgrading from Elevate Express to the full version of Elevate, please select the *About Elevate* dialog box from the Help menu. Use the button provided to release your unlocking code. Then restart the program and follow the instructions to unlock the full version.

Assuming you accept the default installation path, Elevate will be installed in the folder:
C:\Program Files\Elevate.

**Using Elevate**
You can start Elevate in several ways:

- press Start, then select Programs, Elevate
- double click on the Elevate icon on the desktop
- double click on any Elevate document.

Optionally, you can create a new Elevate document without starting Elevate. Right click in a blank part of your desktop and select New, Elevate Document.

Elevate documents have an .elv extension.

You can view the latest version of the manual at any time by selecting Elevate Manual from the Help menu.

We recommend that you read this manual and try out the features discussed before using Elevate on actual projects. Advanced mode sections can be skipped if you are only using the basic functions of Elevate.

This guide assumes that you are familiar with the version of Windows you are using. If you are not, please refer to Windows documentation and help systems before using Elevate.
3. Technical Support

Getting Help
First please read the documentation provided.

Answers to common questions can be found on our web site. Please select Elevate on the web from the Help menu, while connected to the Internet.

If you still have questions about using Elevate, please contact us stating:

1. Your name, company and contact details.
2. The version of Elevate you are using (to check these details, select About Elevate on the Help menu).
3. A brief description of the problem.

Our contact details are as follows. Email is our preferred means of communication as it allows us to give a fast, but considered response to your question. It is helpful if you attach a copy of the .elv Elevate document to your email.

email
support@peters-research.com

postal address
Boundary House, Missenden Road, Great Kingshill, Bucks HP15 6EB, United Kingdom

telephone
+44 (0)1494 717821

facsimile
+44 (0)1494 716647

Your Feedback Counts!
We want to hear your comments on Elevate, so that we can make it even better. What additional features would you like to see? Does anything annoy or frustrate you?

Although we cannot promise to incorporate every request, all suggestions will be seriously considered. Please contact Technical Support at any time.
4. The Elevate Screen

Main Display Area
The main display area provides a graphical representation of the building. When a simulation is running, the elevators and calls placed on the system are displayed. When a Round Trip Time calculation is being performed, a progress report is displayed. This is discussed in more detail in Chapter 11,
Running the Analysis. Once the analysis is complete, the main display area provides a preview of the data and results that can be printed. This is discussed in Chapter 12, Viewing the Results.

Accessing Elevate Commands

Commands can be accessed from the menu system in the conventional manner using the mouse. Alternatively, shortcut keyboard commands can be used, e.g. press \texttt{Alt} plus \texttt{F} to select file menu, then \texttt{P} to select print (the underlined letter denotes the shortcut key). Some frequently used commands can also be accessed from the Toolbar. A description of each button’s function is displayed when the mouse pointer is placed on the button (without clicking). The Toolbar can be dragged to a new position if required (point to a blank portion of the Toolbar, click and drag).
File Menu

The File menu offers the following commands:

- **New**: Creates a new document.
- **Open**: Opens an existing document.
- **Close**: Closes an opened document.
- **Save**: Saves an opened document using the same document name.
- **Save As**: Saves an opened document to a specified document name.
- **Page Setup**: Edit the number of lines per page for the result print out. This increases/decreases the font sizes used.
- **Print**: Prints a document.
- **Print Preview**: Displays the document on the screen as it would appear printed.
- **Print Setup**: Selects a printer and printer connection.
- **Exit**: Exits Elevate.

The File menu also provides a numbered list of the four most recently used documents. Select from this list for quick access to these documents.

Edit Menu

The Edit menu offers the following commands:

- **Job data**: Information about the job.
- **Analysis Data**: Information about the analysis.
- **Building Data**: Information about the building.
- **Elevator Data**: Information about the elevators.
- **Passenger Data**: Information about the passengers.
- **Report Options**: Options that select which results are presented.

The contents of these dialog boxes are discussed in the following chapters. Once you have opened one of these dialog boxes, you can switch between them quickly by using the Next and Back buttons.

Analysis Menu

The Analysis menu offers the following commands:

- **Run**: Run the analysis.
- **Run Fast**: Run the analysis as quickly as possible.
- **Pause**: Pauses the analysis.
- **Pause Look**: Pauses the analysis and review the status of the elevators and calls.
- **Stop**: Stops the analysis.
- **Run Batch**: Select a folder and batch run all the Elevate files in that folder.
- **Deletes Result**: Deletes the analysis results. As results are saved with the Elevate file, the action of deleting the results will reduce the file size.

Tools Menu

The Tools menu offers the following commands:

- **Kinematics**: Provides analysis of a trip according to the specified speed, acceleration and jerk.
- **Update Version**: Updates the version of Elevate you are using over the Internet.
- **Count**: Starts the Elevate Passenger Count application.
- **System Stimulation**: Provides a list of calls in a format that can be used to stimulate a real elevator system.
- **Motion**: Starts the Elevate Passenger Count application.
View Menu

The View menu offers the following commands:

- **Zoom In**: Magnifies the view of the display.
- **Zoom Out**: Reduces the view of the display.
- **Summary Results**: Displays a summary of all results if a range of configurations has been analysed.
- **Next Results**: Displays the next set of results if a range of configurations have been analysed.
- **Previous Results**: Displays the previous set of results.
- **Results Spreadsheet**: Transfers the current set of results to an Excel spreadsheet.
- **Results Word processor**: Transfers the current set of results to a Word document.
- **Results Graphs**: Presents a dialog in which you can view results graphs individually.
- **Toolbar**: Shows or hides the Toolbar.
- **Status Bar**: Shows or hides the Status bar.

Window Menu

The Window menu offers the following commands:

- **Cascade**: Arranges windows so that they overlap.
- **Tile**: Arranges windows as non-overlapping tiles.
- **Arrange Icons**: Arranges icons at the bottom of the window.

The Window menu also provides a numbered list of the documents that are currently open. Select a document from this list to make it the current, active document.

Help Menu

The Help menu offers the following commands:

- **Elevate Manual**: Accesses the latest version of this manual via the Internet.
- **Elevate on the web**: Opens Peters Research Ltd web pages for Elevate.
- **About Elevate**: Displays Elevate’s About box.

Saving your own default data

Each time you start a new Elevate document, a standard set of default data is loaded.

To create your own default data:

- Start a new Elevate document.
- Make any changes you want (e.g. U.S. units instead of metric, lists of standard elevator capacities, number of lines per page for the print out).
- Save the file as `default.elv` in the directory in which Elevate is installed (normally `C:\Program Files\Elevate`).

This data will now be loaded each time you start a new document. If you delete default.elv, the program will revert to using Elevate’s standard defaults.
5. Job Data

Entering Job Data
You can access Job Data by selecting Edit, Job Data, or by pressing the button on the Toolbar.

![Job Data dialog](image)

Job data allows you to record details of the project, and who has performed the calculations. This information, the date, and document name is included in the header of all Elevate printouts.

By default the Elevate logo will be displayed on the top right of printouts. If you prefer to use your own Logo image file, click on the select button to choose any bitmap, jpeg or gif available from your computer. For best results use a logo with a similar aspect ratio to the Elevate logo. If your logo looks very small on the print outs, this is because the image file is larger than the logo itself. To solve this, resize the image file to have a minimal border using a program such as Windows Paint. If you want your logo to be loaded every time you start a new Elevate document, refer to Saving your own default data in Chapter 4.
6. Analysis Data

Introduction
You can access Analysis Data by selecting Edit, Analysis Data, or by pressing the button on the Toolbar.

This dialog contains general information about the analysis you want to perform. The Analysis type selected here reflects what data is entered in Building Data, Elevator Data and Passenger Data.

Analysis Type
The Analysis type determines what type of calculation will be performed by Elevate. Select between:

Simulation
In a simulation Elevate models the whole process of passengers arriving, pressing the hall call buttons, getting into the elevators when they arrive, and then getting out at their destinations. By monitoring every passenger, Elevate provides an analysis that includes Passenger Waiting Times and Passenger Transit Times.

Up peak
In an up peak calculation you assume that all passengers get into the elevators at the lowest, “main terminal” floor. The destinations of passengers are determined by the population of upper floors, as entered in Passenger Data. Elevate uses formulae to calculate the Interval and Handling Capacity of the system. This analysis
method will provide similar results to most other elevator planning software and hand calculations providing that consistent input data is used.

**Enhanced up peak**
This performs the same calculation as the Up peak analysis type, but allows you to enter the required Handling Capacity (Capacity Factor is adjusted automatically during the analysis so that the required Handling Capacity is achieved). This is a much quicker way to find solutions when you are designing to a specified Handling Capacity and Interval.

**General analysis**
This analysis method gives similar results to the Enhanced up peak, but you are no longer restricted to passengers getting into the elevators at the lowest floor in the building. Passengers can get into the elevators at any or all floors. This is particularly useful for buildings with multiple entrance floors, car parks and basements. Elevate uses formulae to calculate Interval and Capacity Factor for the system.

**Double Deck General analysis**
This analysis method is the equivalent of the General analysis, but for double deck elevators. Passengers can get in at any or all floors. Passengers may only travel from odd to odd or even to even number floors.

For more information about the analysis techniques used by Elevate, please select Elevate on the web from the Help menu.

**Measurement System**
Choose whether you want to use Metric or U.S. (Imperial) units for this analysis. Your selection here will determine whether Elevate uses “metres and kilograms” or “feet and pounds” in the other dialog boxes, and for output of results.

**Dispatcher**
These inputs are only applicable and active when the Analysis type is Simulation. The dispatcher algorithm determines how the elevators will serve the calls placed on the system by the passengers.

Select either Standard or Custom Algorithms. Custom algorithms are only available if you have chosen to implement your own algorithms using the Developer interface.

Select the chosen Algorithm, Mode and Advanced Options. For Standard algorithms, the available options are discussed below.

**Group Collective**
A control system that allocates hall calls by (i) estimating the expected travel distance between hall calls and each elevator; (ii) allocating the call to the “nearest” elevator. Allocations are regularly reviewed in case a delay to one elevator means that another could answer the call sooner. A load bypass feature is included to avoid the elevator stopping to pick up passengers when it is already full.

In Up peak 1 mode, “idle” cars are returned to the Home Floor with a parking call that does not open the elevator doors on arrival. This strategy normally improves up peak traffic handling. Using this algorithm elevators are loaded one at a time. This encourages people to fill one elevator rather than part fill two or more elevators.

In Up peak 2 mode “idle” cars are returned to the Home Floor with a parking call which opens the elevator doors on arrival. This strategy improves on Up peak 1 for particularly heavy traffic situations when it is advantageous to load more than one elevator at a time. If this is not the case, the algorithm is normally less efficient than Up peak 1.
In **Down peak** mode, the served floors above the **Home Floor** are divided into sectors, where the number of sectors is equal to the number of elevators. Elevators are dispatched to the sectors in turn. When the elevator has served the down calls in its allocated sector, it is allowed to stop for additional hall calls in its path on the trip back to the **Home Floor**. This strategy normally improves performance when the predominant traffic flow is in the down direction towards the home floor.

In **Auto** mode, up and down peak detection is used to turn the **Up peak** and **Down peak** modes on and off. The detection parameters are accessed by clicking on the **Advanced settings** button.

For, **Up peak** detection, when a car leaves the Home floor, the dispatcher tests if the load exceeds the Load switch detection level (%). The Up peak detection counter is incremented by 1 when a car leaves with a load above the Load switch detection level and is decremented if the load is below that level. When the counter reaches the On level, the up peak program is switched on. A blocking system ensures that the up peak detection counter does not exceed the On level. If the up peak program is on, the Clock inhibit timer decrements the Up peak detection counter by 1 at fixed time intervals, as defined by the Clock rate. When the up peak detection counter reaches the Clock inhibit level, the Clock inhibit timer is switched off. When the Up peak detection counter reaches the Off level (always set at 1), the up peak program is turned off.

Down peak detection operates as per the up peak detection system, except that the load is measured as the car arrives at the home floor; the down peak as opposed to up peak program is initiated.

**Estimated Time of Arrival (ETA)**

A control system that allocates halls calls to the elevator with the lowest Estimate Time of Arrival.

In **Up peak** mode, “idle” cars are returned to the **Home Floor** with a parking call that does not open the elevator doors on arrival. This strategy normally improves up peak traffic handling. Using this algorithm elevators are loaded one at a time. This encourages people to fill one elevator rather than part fill two or more elevators.

**Early car announcement** can be turned on or off. When turned on, it is assumed that as soon as a passenger places a hall call, the allocated car is “announced” with a gong and or/light. This can assist in passenger loading, which can be modelled in Elevate by reducing **Passenger Loading Time**. However, when a call is announced it can no longer be re-allocated. This generally impairs the performance of the dispatcher.

**Load bypass** can be turned on or off. Turned on, this feature will prevent hall calls from being allocated to full cars. The **Load bypass threshold** determines how full a car is before load bypass comes into operation.

**Coincident call bonus** reduces the calculated ETA for a hall call if the elevator is already stopping at the same floor for a car call. This normally reduces the overall number of stops made by the elevator, and consequently improves performance.

**Number of cars loading simultaneously during up peak** allows you to specify the maximum number of elevators you want to be able to load at the same time, during an up peak, from the **Home Floor**. Normally a system would only load one car at a time. But in heavy traffic situations it can be advantageous to load more. The **based on people counter at home floor** option assumes that there is a people counting device at the home floor. This device decides how many people are waiting, and uses this information to decide how many elevators to load simultaneously.

**Destination Dispatch (ACA)**

Destination Dispatch or Adaptive Hall Call Allocation (ACA) requires every passenger to enter his or her destination on the landing. When a call is entered the systems makes an allocation, and immediately displays the selected elevator to the passenger.

When a new call is introduced, the system calculates every passenger’s remaining waiting and transit times for each possible allocation. The allocation is made according the selected **Cost Function**, which is either **Minimum Waiting Time** or **Minimum Journey Time**.
Minimum Journey Time is generally applied during the morning up peak. Either function may be applied at other times of the day.

Minimum journey time with waiting time constraint is a Minimum Journey Time function. However, a penalty is applied if the dispatcher anticipates the waiting time will exceed the specified threshold level.

Reduction in number of stops can be applied to increase the chance of people travelling to/from the same floors being allocated to the same elevator.

For a detailed discussion of this algorithm, please refer to the Elevator Traffic Handbook by Dr Gina Barney.

Allow allocations requiring doors to re-open is an option which determines whether or not the dispatcher is allowed to allocate a new destination call at the elevator’s current floor. Re-opening the doors delays the passengers already in the car, but may reduce the new passenger’s waiting time significantly.

Destination Dispatch can dramatically improve performance during up peak traffic.

Caution! This improvement is not consistent across all traffic conditions. If you select less, slower, or smaller elevators because of the performance improvements realized by destination dispatch, it is very important to analyse other peak traffic conditions (e.g. down peak and lunchtime traffic).

Double Deck
A control system for double deck elevators that allocates hall calls to the car with the lowest Estimate Time of Arrival (ETA). Traffic must be arranged so that passengers only travel (i) from odd numbered floors to other odd numbered floors, and (ii) from even numbered floors to other even numbered floors.

In Up peak mode, “idle” cars are returned to the Home Floor with a parking call which does not open the elevator doors on arrival. This strategy normally improves up peak traffic handling. Using this algorithm elevators are loaded one at a time. This encourages people to fill one elevator rather than part fill two or more elevators.

In Heavy up peak mode “idle” cars are returned to the Home Floor with a parking call that opens the elevator doors on arrival. This strategy improves on Up peak for particularly heavy traffic situations when it is advantageous to load more than one elevator at a time. If this is not the case, the algorithm is normally less efficient than Up peak.

Double Deck Destination Dispatch
A control system for double deck elevators that requires every passenger to enter his or her destination on the landing. When a call is entered the systems makes an allocation, and immediately displays the selected elevator to the passenger. Traffic must be arranged so that passengers only travel (i) from odd numbered floors to other odd numbered floors, and (ii) from even numbered floors to other even numbered floors.

When a new call is introduced, the system calculates every passenger’s remaining waiting and transit times for each possible allocation. The allocation is made according to the selected Cost Function, which is either (i) Minimum time to destination, (ii) Minimum waiting time or (iii) Minimum 3x waiting time + transit time, for which waiting time is deemed to be three times as important as transit time when choosing which car to allocate.

Allow allocations requiring doors to re-open is an option which determines whether or not the dispatcher is allowed to allocate a new destination call at the elevator’s current floor. Re-opening the doors delays the passengers already in the car, but may reduce the new passenger’s waiting time significantly.

Interfaces
Elevate can be used for basic elevator traffic monitoring using an open standard XML interface defined by Dr J Beebe at www.std4lift.info. This is a demonstration feature, which will be extended if our clients wish to apply Elevate as a monitoring tool. To try this feature, open two copies of Elevate. Set the first copy to XML Output.
Getting Started with Elevate

Set the second copy to XML Input for Remote Monitoring. Then select Analysis, Run on both copies of Elevate. The second copy of Elevate will mimic the simulation run on the first copy.

**Time Slice Between Simulation Calculations**
This input is only applicable and active when the Analysis type is Simulation.

Elevate runs a time slice simulation. It calculates the status (position, speed, etc.) of the elevators, increments the time, re-calculates status, increments time, and so on. The time slice between simulation calculations is the time increment in this loop.

**No of Time Slices Between Screen Updates**
This input is only applicable and active when the Analysis type is Simulation.

Elevate does not have to update the screen after each time slice. Increasing the No of time slices between screen updates will speed up the simulation, but the display will be less smooth during the run. This variable has no effect on the final results calculated by Elevate.

If you want to turn off the simulation display completely, set this variable to 999.

**Random number seed for passenger generator**
This input is only applicable and active when the Analysis type is Simulation.

When Elevate runs a simulation, it takes the information entered in Passenger Data and makes a list of people. For example, if you have a total arrival rate of 10 persons per five minutes, and a simulation running for 5 minutes, then a list of 10 people will be generated.

A random number generator is used to determine at what time these people arrive. For example, one person may arrive after 10 seconds, another after 23 seconds, another after 1 minute 23 seconds, and so on.

By changing the random number seed, the simulation will have the same number of people generated, but they will arrive at different times.

**Number of simulations to run for each configuration**
This input is only applicable and active when the Analysis type is Simulation.

There is a chance element in simulation which means that changing a parameter, such as speed or handling capacity, can sometimes lead to performance results getting worse when you expect them to get better (or vice versa). For example, consider two simulations with exactly the same data, except one had 2.5 m/s elevators and the other 1.6 m/s. In a single simulation with 2.5 m/s elevators, a group of passengers may miss an elevator by less than a second, where as in the simulation with 1.6 m/s elevators they catch it. So, sometimes the faster elevators perform worse. Of course, in the long run, the faster elevators will perform better. By running multiple simulations for the same data, Elevate is mimicking real life. It is as if we are simulating Monday, Tuesday, Wednesday, etc. The results are then averaged for all the simulations, so overall we can see the benefit of the improved performance.

**Losses**
This input is only applicable and active when the Analysis type is Up peak, Enhanced up peak or General analysis.

Some designers add a % to the calculated value of Round Trip Time (RTT) to allow for controller inefficiencies and people holding doors, etc. To increase RTT in this way, enter a value here. Alternatively, enter zero.
7. Building Data

Introduction
You can access Building Data by selecting Edit, Building Data, or by pressing the button on the Toolbar.

![Building Data dialog]

The Building Data dialog contains information about the building.

To speed up your data entry, all Elevate tables are designed to operate like Microsoft Excel spreadsheets.

Your selection of Measurement System in Analysis Data will determine whether Elevate asks for data in Metric or U.S. units. Metric units will be assumed for discussion in this chapter.

Floor Name
You must give every floor in the building a unique floor name, entering the floors in sequence, lowest first.

You can enter the floor names in the table individually. However, we recommend that you use one of the speed-fill functions. Either use the Speed fill table button or

- Click on the cell in row 1 under the Floor Name column.
- Type in Basement, Ground, or Level 1 depending on how you want to identify the lowest floor in the building.
• Keep pressing Enter on the keyboard until the number of floors matches the building being modelled.
• With the mouse, click any cell other than the current one to stop the auto-fill.

You could start the auto-fill at another cell, for instance by typing Ground in row 4, having entered the names of four basement floors.

You can insert additional floors at the beginning or middle of the table by highlighting and dragging cells as you would in a spreadsheet.

**Floor Level and Floor Height**

First use the radio buttons below the table to specify whether you want to enter the height of each floor (e.g. 5 m, 3.6 m, 3.6 m.) or the level of each floor (e.g. 0 m, 5 m, 8.6 m, 12.2 m).

You can enter floor levels or heights individually. However, we recommend that you use one of the speed-fill functions. Either use the Speed fill table button or, if entering floor heights:

• Enter 3.6 in row 1 of the Floor Height column and press Return.
• Click again on the cell in row 1 of the Floor Height column to select it.
• Point to the bottom right hand corner of the cell (the pointer will turn into a small cross).
• Click and drag the black cross down the table.

**Speed fill table**

This is normally the fastest way to fill the Building Data table.

The Speed fill table button allows you to select from a number of pre-defined floor name series, then specify the number of floors and floor height (or total travel). The Edit series option allows you to define your own series.

![Building Data Speed fill dialog](image)

If you define your own series, and want these series to be available in future documents, please refer to Saving your own default data.

**Express zone**

Select the lowest floor not served by the elevators, and the highest floor not served by the elevators to specify an express zone.

If your Analysis Type is a Round Trip Time calculation (Up peak, Enhanced up peak, General analysis or Double Deck General analysis), it is important to tell Elevate if you have an express zone so that the calculation is able to make its best estimate of the average distance between stops. In simulation it is not essential to tell Elevate that there is an express zone provided that passengers are not sent to or from un-served floors. However, for consistency, we suggest that you always specify any express zone in Building Data. Please see the examples provided.
8. Elevator Data

Introduction
You can access Elevator Data by selecting Edit, Elevator Data, or by pressing the button on the Toolbar. The Elevator Data dialog contains information about the elevators. There are two modes:

Standard This provides a quick and easy way to enter data, which is sufficiently detailed for most cases. If you use any Select options, Elevate will run in sequence a separate analysis for each possible configuration. If you use only Specified options, Elevate will run a single analysis.

Advanced This mode can only be used when the Analysis type is Simulation. Parameters are specified individually for each elevator, so in the same group, elevators can have different speeds, capacities, etc. Elevate runs a single simulation in Advanced mode.

You can change between the modes by clicking on the radio buttons labelled Standard and Advanced. All the variables are discussed in the following sections. Your selection of Measurement System in Analysis Data will determine whether Elevate asks for data in Metric or U.S. units. Metric units will be assumed for discussion in this chapter.

STANDARD MODE

Figure 6 Elevator Data dialog, Standard Mode
Number of Elevators

The number of elevators in the group. This can be **Selected** over a range, or **Specified** to be an exact number. Elevate will allow you to analyse a group of up to 12 elevators (it is unusual to have more than 8 elevators in a single group). Please contact Technical Support if you need to analyse a group of more than 12 elevators.

Capacity

The rated (contract) load, in kilograms, of each elevator car. This can be **Specified** to be an exact number, or you can **Select** over a range. A list of standard capacities is used for the **Select** option. To modify this list, click on the button marked **list**.

For double deck elevators, the capacity entered here is the capacity of each deck. For example, 1000 kg would indicate that each of the two cars has a 1000 kg capacity.

Door Times

The door pre-opening, opening and closing times. These can be selected **Automatically**, or **Specified** to be exact numbers.

Door **pre-open** is the improvement in door opening time achieved by overlapping the levelling operation with the first part of the opening of the doors, in seconds.

Door **open** is the time, in seconds, from the instant of the elevator car being level at a floor to when the doors are fully open. Elevate assumes passenger transfer begins at the end of the door open time. If, like some designers, you want to assume that passenger transfer begins before the doors are fully open, you can take the door open time to be from the instant of the elevator car being level at a floor to when the doors are (say) 800 mm open.

Door **close** is the time, in seconds, from the instant the car doors start to close, to the time when they are locked closed.

If the **Auto** option is used, Elevate uses the **Capacity** to decide door width, from which door times are selected as follows. The open and close times chosen are typical of high speed centre-opening doors.

**Table 8.1** Automatic door selection for Metric units analysis

<table>
<thead>
<tr>
<th>Capacity (kg)</th>
<th>Door Width (mm)</th>
<th>Door Pre-Open Time (s)</th>
<th>Door Open Time (s)</th>
<th>Door Close Time (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>630</td>
<td>800</td>
<td>0.0</td>
<td>1.5</td>
<td>2.0</td>
</tr>
<tr>
<td>800</td>
<td>800</td>
<td>0.0</td>
<td>1.5</td>
<td>2.0</td>
</tr>
<tr>
<td>1000</td>
<td>1100</td>
<td>0.0</td>
<td>1.8</td>
<td>2.9</td>
</tr>
<tr>
<td>1250</td>
<td>1100</td>
<td>0.0</td>
<td>1.8</td>
<td>2.9</td>
</tr>
<tr>
<td>1600</td>
<td>1100</td>
<td>0.0</td>
<td>1.8</td>
<td>2.9</td>
</tr>
<tr>
<td>1800</td>
<td>1100</td>
<td>0.0</td>
<td>1.8</td>
<td>2.9</td>
</tr>
<tr>
<td>2000</td>
<td>1100</td>
<td>0.0</td>
<td>1.8</td>
<td>2.9</td>
</tr>
<tr>
<td>2500</td>
<td>1100</td>
<td>0.0</td>
<td>1.8</td>
<td>2.9</td>
</tr>
<tr>
<td>3000</td>
<td>1100</td>
<td>0.0</td>
<td>1.8</td>
<td>2.9</td>
</tr>
</tbody>
</table>

**Table 8.2** Automatic door selection for U.S. units analysis

<table>
<thead>
<tr>
<th>Capacity (lb)</th>
<th>Door Width (in)</th>
<th>Door Pre-Open Time (s)</th>
<th>Door Open Time (s)</th>
<th>Door Close Time (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1500</td>
<td>36</td>
<td>0.0</td>
<td>1.5</td>
<td>2.1</td>
</tr>
<tr>
<td>2000</td>
<td>36</td>
<td>0.0</td>
<td>1.5</td>
<td>2.1</td>
</tr>
<tr>
<td>2500</td>
<td>48</td>
<td>0.0</td>
<td>1.9</td>
<td>2.9</td>
</tr>
<tr>
<td>3000</td>
<td>48</td>
<td>0.0</td>
<td>1.9</td>
<td>2.9</td>
</tr>
<tr>
<td>3500</td>
<td>48</td>
<td>0.0</td>
<td>1.9</td>
<td>2.9</td>
</tr>
<tr>
<td>4000</td>
<td>48</td>
<td>0.0</td>
<td>1.9</td>
<td>2.9</td>
</tr>
<tr>
<td>4500</td>
<td>48</td>
<td>0.0</td>
<td>1.9</td>
<td>2.9</td>
</tr>
<tr>
<td>5000</td>
<td>48</td>
<td>0.0</td>
<td>1.9</td>
<td>2.9</td>
</tr>
<tr>
<td>5500</td>
<td>48</td>
<td>0.0</td>
<td>1.9</td>
<td>2.9</td>
</tr>
<tr>
<td>6000</td>
<td>48</td>
<td>0.0</td>
<td>1.9</td>
<td>2.9</td>
</tr>
</tbody>
</table>
If the Analysis type is Simulation, Elevate also needs door dwell times. Elevate uses two dwell times:

Door Dwell 1 is the time, in seconds, that the doors will wait until closing if the passenger detection beam across the door entrance is not broken.

Door Dwell 2 is the time, in seconds, that the doors will wait until closing after the broken passenger detection beams are cleared.

Door Dwell 1 is automatically set to 3 seconds, and Door Dwell 2 to 2 seconds when you are using Standard mode. To use alternative values, you must use Advanced mode.

In Advanced mode the inputs Home Door Dwell 1 and Home Door Dwell 2 allow you to set a different door dwell times for the Home floor.

**Speed, Acceleration and Jerk**

Elevate uses a speed reference generator to calculate flight times between floors, and to track the exact position of elevators during a simulation.

![Example speed profiles](image)

**Figure 7** Example speed profiles

You can control this speed profile completely by entering your values for:

Rated (contract) speed, in m/s. This can be Specified to be an exact number, or Selected over a range. A list of standard speeds is used for the Select option. To modify this list, click on the button marked list.

Acceleration in m/s². This can be selected Automatically or Specified as an exact value. If the Auto option is used, Elevate uses the table below to select an acceleration appropriate to the elevator speed.

Jerk in m/s³. This can be selected Automatically or Specified as an exact value. If the Auto option is used, Elevate uses the table below to select a jerk appropriate to the elevator speed.

**Table 8.3** Automatic acceleration and jerk selection for Metric units analysis

<table>
<thead>
<tr>
<th>Speed (m/s)</th>
<th>Acceleration (m/s²)</th>
<th>Jerk (m/s³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.30</td>
<td>0.4</td>
<td>0.8</td>
</tr>
<tr>
<td>0.63</td>
<td>0.4</td>
<td>0.8</td>
</tr>
<tr>
<td>1.00</td>
<td>0.7</td>
<td>1.4</td>
</tr>
<tr>
<td>1.60</td>
<td>0.8</td>
<td>1.6</td>
</tr>
<tr>
<td>2.50</td>
<td>1.0</td>
<td>1.6</td>
</tr>
<tr>
<td>3.15</td>
<td>1.2</td>
<td>1.6</td>
</tr>
<tr>
<td>5.00</td>
<td>1.5</td>
<td>1.6</td>
</tr>
<tr>
<td>6.00</td>
<td>1.5</td>
<td>1.6</td>
</tr>
<tr>
<td>7.00</td>
<td>1.5</td>
<td>1.6</td>
</tr>
<tr>
<td>8.00</td>
<td>1.5</td>
<td>1.6</td>
</tr>
</tbody>
</table>
### Table 8.4  Automatic acceleration and jerk selection for U.S. units analysis

<table>
<thead>
<tr>
<th>Speed (ft/min)</th>
<th>Acceleration (ft/s²)</th>
<th>Jerk (ft/s³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>150</td>
<td>1.31</td>
<td>2.62</td>
</tr>
<tr>
<td>200</td>
<td>1.31</td>
<td>2.62</td>
</tr>
<tr>
<td>300</td>
<td>1.31</td>
<td>2.62</td>
</tr>
<tr>
<td>400</td>
<td>2.30</td>
<td>4.59</td>
</tr>
<tr>
<td>500</td>
<td>2.62</td>
<td>5.25</td>
</tr>
<tr>
<td>700</td>
<td>3.28</td>
<td>5.25</td>
</tr>
<tr>
<td>1000</td>
<td>3.94</td>
<td>5.25</td>
</tr>
<tr>
<td>1200</td>
<td>4.92</td>
<td>5.25</td>
</tr>
<tr>
<td>1400</td>
<td>4.92</td>
<td>5.25</td>
</tr>
<tr>
<td>1600</td>
<td>4.92</td>
<td>5.25</td>
</tr>
</tbody>
</table>

### Start Delay

The **Start Delay** is measured from the when the elevator doors are fully closed until the elevator actually starts moving. Start up delay may include time to pre-torque the motor, close the door locks, lift the break, etc.

### Home Floor

The default floor to which the elevator returns when allocated a parking call (e.g. in up peak mode), and its starting point at the beginning of a simulation or a round trip time calculation. For example, if you had an office building with a basement and 2 car parking floors below ground, you could set the **Home Floor** to be ground.

If the **Analysis type** is Up peak or Enhanced up peak, the **Home Floor** is fixed at the lowest floor in the building as this is an assumption required by the calculation.
ADVANCED MODE

Advanced mode can only be used when the Analysis type is Simulation. In Advanced mode, data is entered in a table. As in Building Data this table operates like a Microsoft Excel spreadsheet; you can use formulae, speed fills, drag and drop, etc. to help with data entry.

When you change from Standard to Advanced mode the data you have entered is not transferred to the Advanced mode. However Elevate does convert the data when you start an analysis, so having run a simulation you can switch to and continue in Advanced mode.

Caution! In Advanced mode, Elevate allows you to have elevators in the same group with different sizes, speeds, etc. (which is unusual, but an occasional requirement). Some manufacturers’ control systems cannot cope with this level of complexity, so check with your suppliers before specifying this type of system.

Floors Served

Advanced mode also allows you to define a group of elevators where not all elevators serve all floors. For example, in a building there may be a group of four elevators, but only one served the basement. Select the Floors Served tab if this option is required. This feature should not be used to model express zones, which is can be defined in Building Data.

Caution! If not all the elevators serve all the floors, then a person may press a hall call button, and have their call answered by an elevator which does not serve their destination. As a default, Elevate assumes that the person will get into the car, travel to the nearest floor to their destination, and then walk the rest of the way.
MG shut down and restart time

These options assist in modelling existing installations which have motor generators installed. To disable the feature, set both MG shutdown time and MG restart time to 0.

MG shutdown time is the time after which an idle elevator will shut down its motor generator set. MG restart time is the time it takes to restart the motor generator set. Restart is initiated when the elevator is allocated a hall call.

Max door re-openings

The Max door re-openings parameter mimics some elevator controllers, which limit the number of times doors will re-open in response to passengers arriving and pressing a hall call button while the elevator doors are closing. Some dispatchers may override these settings (e.g. destination dispatch). Unless you specifically want to research the impact of the door re-openings, we suggest you leave this parameter at its default value, “unlimited”.
9. Passenger Data

Introduction
You can access Passenger Data by selecting Edit, Passenger Data, or by pressing the button on the Toolbar.

Figure 9  Passenger Data dialog, Standard Mode

The Passenger Data dialog contains information about the passengers using the elevators. There are three modes in which you can enter your data:

**Standard**  This provides a quick and easy way to enter data which is sufficiently detailed for most cases.

**Advanced**  Advanced Data can only be used when the Analysis type is Simulation or General analysis. Use this for detailed modelling, when you need to define passenger destinations more precisely, consider changing traffic levels, or introduce different types of loads.

**File**  This option is only available when the Analysis type is Simulation. It allows you to specify a list of passengers entered in a text file rather than use Elevate’s passenger generator.

You can change between the modes by clicking on the radio buttons labelled Standard, Advanced and File.

Your selection of Measurement System in Analysis Data will determine whether Elevate asks for data in Metric or U.S. units. Metric units will be assumed for discussion in this chapter.
STANDARD MODE

Floor Population, Area and Area/person
Enter the population of each floor in the table. Or enter the area and area per person allowed. For example, entering 800 m² area and 10 m²/person would be the same as entering a population of 80 people.

The population is used to determine passenger destinations, e.g. if the population of floor x is 50 people, and the population of floor y is 100 people, a passenger travelling from floor z is twice as likely to want to travel to floor y as he/she is to floor x. The total population is also used as a variable in determining the number of passengers to be transported.

Entrance floors (as set in Entrance level bias) are required to have zero population. If there is likely to be significant traffic between entrance floors at peak times, Advanced mode should be used.

Entrance level bias
This input table is only applicable and active when the Analysis type is Simulation, General analysis or Double Deck General analysis.

Entrance level bias defines the main entrance/exits to the building. If the “Ground” is the only entrance/exit, then set the % bias for this floor to 100 and other floors to 0. If there is a “Basement Car Park” it is likely that some passengers arrive and leave by this entrance. If, for example, the bias is set to 30% for the “Basement Car Park” and 70% for the “Ground”, then Elevate will divide incoming and outgoing traffic between the floors on this basis.

For double deck elevators, the Entrance level bias is presented in groups of two floors. For example, the bias for “Level -1 and Level –2” could be set to 30%, and the bias for “Level 0 and Level 1” could be 70%.

Passenger Mass
The nominal mass of a passenger in kilograms.

Loading Time
The time taken, in seconds, for a single passenger to load the car.

Unloading Time
The time taken, in seconds, for a single passenger to unload from the car.

Stair Factor
Stair Factor provides a quick and easy way to make an allowance for stair (or escalator) usage in your calculations.

If you enter a Stair Factor of x, Elevate assumes that x% of the passengers will walk when travelling one floor, (x% of x%) will walk when travelling two floors, and (x% of x% of x%) will walk when travelling three floors. For example if you enter a Stair Factor of 40%, Elevate will assume the following split of passengers between the stairs and the elevators:
If the assumptions of the **Stair Factor** are not appropriate, use a value of 0% and modify the floor populations or arrival rates and destination probabilities instead. You should always use a **Stair Factor** of 0% if the building includes an express zone.

**Capacity Factor**

Capacity Factor (%) allows for passengers not loading the elevators to their rated capacity.

When the Analysis type is **Enhanced up peak** or **General analysis** you do not need to enter a value. As you are entering details of how many passengers are using the elevators, Elevate will calculate the resulting **Capacity Factor**. When the **Analysis type** is **Simulation**, if the **Capacity Factor** is x%, a passenger will not enter the car if, by doing so, the car will be greater than x% full by weight. In these instances, Elevate assumes that passengers will wait for the elevator doors to close, and for the elevator to depart before re-registering their hall call.

**Arrangement**

To operate efficiently, it is sometimes necessary to restrict how passengers use the elevators. For example, double deck elevators maximum efficiency will normally correspond to the lower cab serving odd numbered floors and the upper cab serving even number floors. The **Arrangement** options allow the traffic generated by Elevate to be restricted in this way.

The **Conventional** arrangement has no restrictions.

The **Double Deck with no odd to even floor traffic** arrangement assumes that entrance floors are in pairs. Passengers travelling to/from odd floors load at the lower entrance of the floor pair. Passengers travelling to/from even floors load at the upper entrance of the floor pair. Interfloor traffic is restricted to passengers travelling between odd-to-odd floors and even-to-even floors.

Other arrangements are appropriate to other systems (customised versions of Elevate may have other arrangements available). The **first floor served above upper zone variable** relates to a proprietary system and is not active in the general release version of Elevate. If you are designing a system that benefits from traffic being arranged in a specific way, please contact Technical Support.

**Template**

This input is only applicable and active when the **Analysis type** is **Simulation**. Using the floor population you have entered, Elevate will generate traffic based on the selected template.

Some templates require additional parameters. Additional parameters are greyed out unless they are required.

A description of all the templates and their parameters is given in Appendix A.

**Handling Capacity (% pop per 5 mins)**

This input is only applicable and active when the Analysis type is **Enhanced up peak**, **General analysis** or **Double Deck General analysis**. It is also used for some of the **Simulation** templates, as discussed in Appendix A.
Handling Capacity is the % of the given population wanting to use the elevators in a 5 minute period.

If the Analysis type is Enhanced up peak, all traffic is assumed to originate from the lowest floor of the building, and travel up the building.

If the Analysis Type is General analysis or Double Deck General analysis the traffic may be divided into the following components.

- **% incoming**: the part of the total traffic that corresponds to passengers arriving at the entrance floor(s), and travelling up the building, or down to any floors below the entrance floor(s).
- **% outgoing**: the part of the total traffic that corresponds to passengers arriving at floors above (or below) the entrance floor(s), and travelling to the entrance floor(s).
- **% interfloor**: the part of the total arrival rate that corresponds to passengers travelling between floors other than the entrance floor(s).

The population of individual floors is used to determine (i) the attraction of each floor as a destination for incoming traffic, (ii) the origin of outgoing traffic and (iii) the origin and destination attraction of interfloor traffic.

The %incoming, %outgoing, %interfloor terminology is also used in some of the simulation templates.
ADVANCED MODE

Advanced Data can only be used when the Analysis type is Simulation, General analysis or Double Deck General analysis.

Entering Passenger Data in Advanced mode allows you to enter separate destination probabilities for passengers travelling from each floor.

If the analysis type is Simulation, you can also define a number of periods each with their own set of arrival rates and destination probabilities. Each period has a start time, end time, loading times, and passenger mass, etc. Periods may overlap in time. This allows Elevate to model changing levels of traffic, and to introduce refreshment trolleys, goods loads, etc. into the passenger traffic flow.

When you change from Standard to Advanced mode the data Elevate gives you the option of filling the Advanced mode tables based on the data you have entered in Standard mode.

In Advanced mode, data is entered in a table. As in Building Data this table operates like a Microsoft Excel spreadsheet; you can use formulae, speed fills, drag and drop, etc. to help with data entry.

![Passenger Data dialog, Advanced Mode, All Periods tab](image)

Figure 10  Passenger Data dialog, Advanced Mode, All Periods tab

Click on the All periods tab to select this page. Enter the Start Time, End Time, etc. (see preceding Standard mode section for definitions). The notes column is for your reference only.

Complete the information for as many periods as you require.
Period 1, 2, ....

For all rows completed in All Periods, you must complete the corresponding arrival rate and destination probability table, which can be selected by clicking on the 1, 2, etc. tabs.

**Arrival rates** are entered in persons per five minutes.

**Destination probabilities** are entered as percentages, e.g. if the arrival rate is x persons per five minutes and the destination probability to the nth floor is y%, then y% of the x persons per five minutes are travelling to the nth floor. Note that destination probabilities from any level to the same level must be zero as passengers do not take an elevator from one floor to the same floor.

For double deck elevators, destination probabilities from odd to even floors (and vice versa) must be zero as it is assumed that the lower car serves levels 1, 3, 5, etc. and the upper car serves levels 2, 4, 6, etc.

Passengers are created for the simulation using a random number generator, and applying **Arrival Rate** and **Destination Probability** data.
FILE MODE

File mode can only be used when the Analysis type is Simulation. In this mode Elevate will load a list of passengers from a comma separated text file when a simulation is run. This mode is normally used for testing control systems, rather than for traffic analysis. For each passenger you are required to specify:

- **Arrival time**: The time the passenger starts his or her journey, in seconds past midnight.
- **Arrival floor**: Where the passenger starts his or her journey, where 1 corresponds to the lowest floor as defined in building data.
- **Destination floor**: Where the passenger is travelling to, where 1 corresponds to the lowest floor as defined in building data.
- **Mass**: The mass of the passenger (kg).
- **Capacity factor**: The capacity factor this passenger will base his/her decision on when deciding whether or not to get into the car or wait for another elevator.
- **Loading time**: The passenger loading time (s).
- **Unloading time**: The passenger unloading time (s).
- **Car not service destination decision**: This option is to address scenarios when not all elevators serve all floors. If the passenger’s call is answered by a car which does not serve the destination floor, he/she may choose to either:
  1. Not get it. Wait for this car to depart, then re-register the hall call.
  2. Get in anyway and travel in the car as far as possible towards the destination floor. Then get out of the car and walk the remaining floors.
Set this parameter to 1 or 2 according to how you want the passenger to behave. Note: in destination dispatch systems, the user enters their destination, so a car serving the passenger’s destination will be sent anyway.

A typical file with 4 passengers may look like this:

```
801,8,7,75,80,1.2,1.2,2
810,6,3,75,80,1.2,1.2,2
840,1,12,75,80,1.2,1.2,2
890,4,5,75,80,1.2,1.2,2
```

Note - there needs to be a blank line at the end of your text file, to ensure that the last passenger is picked up by the simulation run.
10. Report Options

Discussion
You can access Report Options by selecting Edit, Report Options, or by pressing the button on the Toolbar.

Report Options allow you to change the results and graphs that are displayed on the Elevate standard reports.

You can change all of the Report Options and immediately regenerate the report without re-running the analysis.

When you are satisfied with the Report Options, print in the usual way.

Choosing the results to display
If you have selected a range of configurations (different numbers, sizes and speeds of cars) to analyse in Elevator Data, you can choose to display only the results that meet criteria you specify. The options available depend on the analysis type.

If the Analysis type is Up peak, results can be rejected on the basis that the configuration achieves less than a specified 5 minute handling capacity.
If the Analysis type is **Enhanced up peak, General analysis or Double Deck General analysis**, results can be rejected on the basis that the interval or capacity factor is higher than specified.

If the Analysis type **Simulation**, you can choose to see the results for any individual run, or for an average of all runs. You can also choose to look at the results for passengers who arrive in a specified time frame. Based on this selection, you may also choose to reject results on the basis that the Average Waiting Time, Average Transit Time, or Average Time to Destination is greater than specified.

**Selecting Graphs to plot**

Elevate will plot a wide range of graphs, according to the boxes ticked in the Report Options table.

For a discussion of the simulation results graphs, please refer to the Chapter 12, **Viewing the Results**. By default the graphs are set to scale automatically. Select the **scale** tab if you want to set the scale yourself.
11. Running the Analysis

Introduction
When you have finished entering data, you can start the analysis by selecting Analysis, Run, or by pressing the ▶ or ▼ button on the Toolbar. You can stop the analysis before it is finished by selecting Analysis, Stop or by pressing ■ on the Toolbar. However, if you Stop the analysis before it is finished, Elevate will not display any results. A pause button ■ is also available. The Pause and look option allows you to view a complete list of the passengers in the simulation and their current status. The status of each elevator, hall calls, car calls, and destination floors is also available.

You can zoom in and out of the Analysis display screen by selecting View, Zoom In or View, Zoom Out. Alternatively, press the ≈ and ≉ buttons on the Toolbar.

Your selection of Measurement System in Analysis Data will determine whether Elevate displays values in Metric or U.S. units. Metric units will be assumed for discussion in this chapter.

SIMULATION DISPLAY
When a simulation is running, you are given a full visual display of the elevators’ operation.

![Simulation Display](image_url)
Floor Names
The Floor Names are displayed, as entered in Building Data. The floor-to-floor heights are drawn to scale according to the Floor Levels, also entered in Building Data.

People Waiting
Indicates the number of people waiting at each landing at the current time.

Elevators
Elevators are displayed according to their current position and door status:

- Indicates that the elevator’s doors are fully closed.
- Indicates that the elevator’s doors are opening or closing.
- Indicates that the elevator’s doors are fully open.

Hall and Car Calls
Hall and car calls are displayed according to their status:

- Indicates up and down hall calls have been registered by waiting passengers.
- Indicates one or more destination calls have been registered. Calls are aligned with the floors on which they are registered.
- Indicates car calls registered by the passengers travelling in each elevator. Car calls are aligned with the floors for which they are registered.
- Indicates a parking call which is used to re-locate an “idle” car. This parking call does not open the elevator doors on arrival (see Dispatcher in Chapter 6, Analysis Data).
- Indicates a parking call which is used to re-locate an “idle” car. This parking call opens the elevator doors on arrival (see Dispatcher in Analysis Data).

Time
Indicates the current time of the simulation in the format, hours : minutes : seconds.

AWT
Indicates the Average Waiting Time of passengers whose calls have already been answered, in seconds. Average Waiting Time is discussed in more detail in Chapter 13.
Simulation Results.

**ATT**
Indicates the Average Transit Time of passengers who have already completed their journey, in seconds. *Average Transit Time* is discussed in more detail in Chapter 13.

**Direction**
Indicates the current direction of the elevator, as is normally indicated at landings using directional arrows above elevator doors.

**Position**
Indicates the absolute vertical position of the elevator, in metres, at the current simulation time. This is calculated from the floor levels, taking into account the distance travelled on any particular journey.

**Speed**
Indicates the absolute speed of the elevator, in metres per second, at the current simulation time.

**Load**
Indicates the total load of passengers in the elevator, in kilograms, at the current simulation time.

**RTT CALCULATION DISPLAY**
When an Up peak, Enhanced up peak, or General analysis is running, details of the configuration being analysed (number of elevators, capacity and speed) is displayed.

![RTT Calculation Display](image)

*Figure 14  RTT Calculation Display*
12. Viewing the Results

Introduction
Data and results are displayed in a print preview format on the main display area once the simulation is complete. The results are presented below the data, so you may need to scroll down the report to see the results.

You can zoom in and out of these results by selecting View, Zoom In or View, Zoom Out. Alternatively, press the and buttons on the Toolbar. If the fonts used are too small or too big when you print, select File, Page Setup to adjust the number of lines per page. If you have analysed a range of configurations using the Standard mode Elevator Data options, you can scan through these results by selecting View, Next Results or View, Previous Results. Alternatively use the and buttons on the Toolbar. To view a summary of data and results for all the configurations analysed, select View, Summary Results. Alternatively, press the button on the Toolbar.

If you change any data (apart from Job Data or Report Options), the analysis results cease to be valid, and the results screen is no longer displayed. You must run the analysis again for new results. More technical information about the calculations performed by Elevate is available. Please select Elevate on the web from the Help menu. Your selection of Measurement System in Analysis Data will determine whether Elevate displays results in Metric or U.S. units. Metric units will be assumed for the discussion of results.

Results are automatically saved with the Elevate file. If you Save the file, and then Open it later you do not need to run the analysis again.

Figure 15 Example RTT calculation results display
Figure 16  Example simulations results display
13. Simulation Results

Introduction
Most simulation results are presented as graphs. You can select which graphs to plot in Report Options.

If you want to copy the graphs to another program, use the button on the toolbar. Select the graph you want, and press the copy button. Press the data button if you would like a table of the data used to plot the graph.

A discussion and sample of the available graphs follows.
### Passenger Demand

**Passenger Demand** plots the traffic that has been generated as a result of your inputs in **Passenger Data**. The traffic is divided into traffic up and down the building.

You can view this graph for any one run, or based on an average of all runs.

![Passenger Demand graph](image)

**Figure 17** Example Passenger Demand graph, from all levels
You can also view this graph for any floor. The following example represents the total traffic originating from level 4 which is travelling up (upper axis), and travelling down (lower axis).

4 Nb. 1000 kg elevators @ 2.50 m/s
Average of all runs

**Passenger Demand**
Up/Down traffic from Level 3 - solid line above/below

Figure 18  Example Passenger Demand graph, from single level
**Total Passenger Activity**

Total Passenger Activity plots the traffic that has been generated as a result of your inputs in Passenger Data. This is a “stacked” graph. The lower line is the incoming traffic originating from the Home floor. The second line adds on top the interfloor traffic. And the top line adds on top the outgoing traffic, travelling towards the Home floor.

You can view this graph for any one run, or based on an average of all runs.

---

**Figure 19** Example Total Passenger Activity Graph
Passenger Transfer by Floor

Passenger Transfer by Floor plots arrivals and departures from the selected floor. This corresponds to what you would observe if you were standing on the landing, counting people as they unload and load the car.

You can view this graph for any one run, or based on an average of all runs.

Figure 20  Example Passenger Transfer Floor graph
Queue Lengths

Queue Lengths shows how many people are waiting at elevator landings. This graph is plotted as a scatter diagram. Each time the queue length changes, another dot is plotted.

This graph can be plotted for a selected floor, or for all floors. If you are plotting “all floors”, the graph corresponds to the total number of people queuing on all the elevator landings.

If you plot the “Average of all runs”, the queue lengths for every run are plotted on top of each other in different colours.

You can view this graph for any one run, or based on an average of all runs.

![Queue Lengths graph](image)

Figure 21 Example Queue Lengths graph
**Spatial Plot**

Spatial Plots draw a trace of each car's movement. Spatial plots can be selected for all cars, or for each car individually.

You can select the spatial plot for any single run.

4 No. 1000 kg elevators @ 2.50 m/s  
Average of all runs

No average of Spatial Plots available, so using Run 1

Figure 22 Example Spatial Plot graph
Car Loading on Departure from Home Floor

Car Loading on Departure from Home Floor shows you how full the cars are at the beginning of a round trip. This is of particular interest during up peak traffic. The lower line show the average loading in each five minutes. The upper line shows the highest loading in each five minutes.

You can view this graph for any one run, or based on an average of all runs.

The right hand side y axis (persons) is only displayed when Elevate determines that you have defined all cars to have the same capacity and all passengers to have the same mass.

For double deck cars, the plot refers to the loading of the lower car only.

Figure 23  Example Car Loading on Departure graph
Car Loading on Arrival at Home Floor

Car Loading on Arrival at Home Floor shows you how full the cars are at the end of a round trip. This is of particular interest during down peak traffic. The lower line show the average loading in each five minutes. The upper line shows the highest loading in each five minutes.

You can view this graph for any one run, or based on an average of all runs.

The right hand side y axis (persons) is only displayed when Elevate determines that you have defined all cars to have the same capacity and all passengers to have the same mass.

For double deck cars, the plot refers to the loading of the lower car only.

Figure 24  Example Car Loading on Arrival graph
Dispatch Interval from Home Floor

*Dispatch Interval from Home Floor* plots the interval in each five minutes.

The dispatch interval is the average time between cars departing from the main home floor. This is calculated by counting the number of times a car is dispatched from the home floor in each five minute period. Then dividing this number into 300 seconds (5 minutes).

You can view this graph for any one run, or based on an average of all runs.

![Graph showing Dispatch Interval from Home Floor](image)

**Average Interval 17.7 s (+1.0/-1.0)**

**Figure 25** Example Dispatch Interval graph

Note that during interfloor or light traffic the car may not stop at the home floor regularly. This results in large values for the interval. Thus, at times when there is little traffic to or from the home floor, interval is not a good measure of performance.

**BEWARE!** In simulation a good interval does not necessarily correspond to good performance. For example, the interval may be 20 seconds, but if there are queues on the landing passengers may have to wait two or more intervals before there is enough space for them to get into an elevator. A good interval in destination dispatch simulation does not necessarily correspond to good waiting times, as passengers are often not allocated to the next car to depart from their floor.
Average Waiting Time and Time to Destination

**Passenger Waiting Time** is defined as the actual time a prospective passenger waits after registering a hall call (or entering the waiting queue if a call has already been registered) until the responding elevator doors begin to open. If the responding elevator doors are already open when a passenger arrives, the waiting time for this passenger is taken as zero.

**Passenger Transit Time** is the time the responding elevator doors begin to open to the time the doors begin to open again at the passenger’s destination. If the responding elevator doors are already open when a passenger arrives, the transit time for this passenger commences at the time the passenger arrived.

**Time to Destination** is the **Passenger Waiting Time** plus the **Passenger Transit Time**.

The **Average Waiting Time** and **Time to Destination** graph is plot for each 5 minutes. The lower line is the Average Waiting Time. The upper line is the Time to Destination. The difference between the two lines is the Passenger Transit Time.

![Graph of Average Waiting Time and Time to Destination](Figure 26)

*Figure 26  Example Average Waiting Time and Time to Destination graph*
Passenger Waiting Time Results

Passenger Waiting Time is defined as the actual time a prospective passenger waits after registering a hall call (or entering the waiting queue if a call has already been registered) until the responding elevator doors begin to open. If the responding elevator doors are already open when a passenger arrives, the waiting time for this passenger is taken as zero.

Elevate plots against the right hand side y axis, a graph showing what percentage of passengers have waiting times less than or equal to the value on the x axis. A dotted line identifies the 90 percentile.

Plotted against the y1 axis, Elevate identifies the number of passengers who have waited in each of the specified time ranges.

Elevate also calculates the Average Waiting Time, and identifies the Longest Waiting Time. If the Number of simulations to run for each configuration greater than 1, Elevate presents the average result, and a range, e.g. 30.0 (+5.1/-1.5).

![Graph of Passenger Waiting Times](image)

**Figure 27** Example Distribution of Passenger Waiting Times graph
Passenger Transit Time Results

Passenger Transit Time is the time the responding elevator doors begin to open to the time the doors begin to open again at the passenger’s destination. If the responding elevator doors are already open when a passenger arrives, the transit time for this passenger commences at the time the passenger arrived.

Elevate plots against the right hand side y axis, a graph showing what percentage of passengers have had transit times less than or equal to the value on the x axis. A dotted line identifies the 90 percentile.

Plotted against the y1 axis, Elevate identifies the number of passengers who have had a transit time in each of the specified time ranges.

Elevate also calculates the Average Transit Time, and identifies the Longest Transit Time. If the Number of simulations to run for each configuration greater than 1, Elevate presents the average result, and a range.

![Distribution of Passenger Transit Times](image)

Figure 28  Example Distribution of Passenger Transit Times graph
**Time to Destination**

*Time to Destination* is the *Passenger Waiting Time* plus the *Passenger Transit Time*. Elevate calculates *Average Journey Time* and *Longest Journey Time*.

Elevate displays a graph showing what percentage of passengers have a time to destination less than or equal to the value on the x axis.

Elevate plots against the right hand side y axis, a graph showing what percentage of passengers have had a time to destination less than or equal to the value on the x axis. A dotted line identifies the 90 percentile.

Plotted against the y1 axis, Elevate identifies the number of passengers who have had a time to destination in each of the specified time ranges.

Elevate also calculates the *Average Time to Destination* and, and identifies the *Longest Time to Destination* experienced. If the *Number of simulations to run for each configuration* greater than 1, Elevate presents the average result, and a range.

![Distribution of Time to Destination](image)

**4 Nb. 1000 kg elevators @ 2.50 m/s**

**Average of all runs**

- **Average Time To Destination (s)**: 42.2 (±4.1/-2.7)
- **Longest Time to Destination (s)**: 130.1 (±28.1/-16.8)

**Figure 29** Example Distribution of Time to Destination graph

**Car Service**

This graph plots the availability of cars as part of the group. In simulation all cars are assumed to be in service at all time, so this graph is only useful when using Elevate as a traffic-monitoring tool in real installations. (To model cars being out of service in simulation you can simply delete a car in *Elevator Data*.)
Spreadsheet Results

In addition to the standard Elevate report, you can transfer the data and results, as currently displayed, to Excel by selecting View, Results Spreadsheet. Alternatively, press the button on the Toolbar. If you use a spreadsheet other than Excel, and want to use this spreadsheet facility, please contact Technical Support.

Additional results are provided in the spreadsheet:

- Up, down and total motor starts for each elevator.
- Total up and down running time for each elevator.
- Number of times dispatched from home for each elevator.
- Number of hall calls up, down and total. Average response time.
- Hall call analysis by time of day.
- Hall call analysis by floor number.
- Hall call response time distribution.
- Car call analysis by time of day.
- Car call analysis by floor number.
- Car call response time distribution.
- Passenger list – includes details of every passenger included in the simulation, what time and floor they arrived, which elevator they used, their waiting time and journey time, etc.

For more information about these results, please contact Technical Support.
14. RTT Calculation Results

Interval
This represents the average time in seconds between successive elevator cars arriving at the main entrance floor(s).

Capacity Factor and 5 minute handling capacity (%)
Capacity Factor (%) refers to the most full the elevator will be for an average round trip.

5 minute handling capacity (%) is the percentage of the building population transported by the elevators in five minutes during a morning up peak.

If the Analysis type is Enhanced up peak or General analysis you specify how much traffic there is going to be and Elevate calculates a Capacity Factor. In an Up peak analysis you assume the elevator will be, say 80% full, then calculate the 5 minute handling capacity. Thus only one of these two results is given according to which analysis you are using.

Intermediate Results
Elevate also displays intermediate results calculated during the analysis. For more information about these results, please contact Technical Support.
No Results
Elevate will abort calculations where the **Capacity Factor** is >100% as the configuration is clearly unacceptable. On the results print out for this configuration the message with be displayed: “This configuration has been rejected because the required handling capacity cannot be achieved without increasing the size or number of the cars”.

If you are using the **Report Options**, Elevate will also discard configurations which do not meet any criteria specified. On the results print out for this configuration, the message “This configuration has been rejected due to the Report Options parameters” with be displayed.

If you have no results, adjust the **Report Options**, reduce amount of traffic defined in **Passenger Data**, or increase the specification of the elevators in **Elevator Data**.

If all results are either invalid, or have been rejected due to the **Report Options** settings, the summary results page will display the message “All results are either invalid, or have been rejected due to the Report Options settings”.

Low and Zero Results
Round Trip Time calculations are intended for analysis of **peak** traffic, when the elevators are busy. If this is not the case, some results may be low, or even zero. This is a limitation of the calculation. With Elevate, you can overcome this by changing the **Analysis type** to **Simulation**.

Spreadsheet Results
In addition to the standard Elevate report, you can transfer the data and results, as currently displayed, to **Excel** by selecting **View, Results Spreadsheet**. Alternatively, press the button on the Toolbar. If you use a spreadsheet other than **Excel**, and want to use this spreadsheet facility, please contact Technical Support.
### Figure 32  Example Spreadsheet output of RTT results

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>JOB DATA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>ELEVATE Version 6.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>© Peters Research Ltd. 2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Job Title</td>
<td>Elevate Testing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Job No</td>
<td>n/a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Calculation Title</td>
<td>Up peak</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Made By</td>
<td>rdp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Date</td>
<td>02-Jan-04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>File</td>
<td>Example 1a.elv</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Date</td>
<td>02-Jan-04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Analysis Type</td>
<td>Enhanced up peak calculation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Measurement System</td>
<td>Metric</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Losses (%)</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Floor Name</td>
<td>Floor Height (m)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Ground</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Note: The table above shows an example spreadsheet output of RTT (Round Trip Time) results.*
Introduction
The Tools menu is provided for additional analysis features not directly related to the main calculations. The following tools are available.

Kinematics
The kinematics tool allows you to select any trip, and the speed, acceleration and jerk.

![Kinematics dialog](image)

**Figure 33** Kinematics dialog

When you click on the Calculate button, an Excel spreadsheet is generated providing a detailed kinematics analysis of the trip including:

- Flight time.
- Maximum speed achieved during trip.
- Details as to whether or not the elevator reached rated acceleration and speed during the specified trip.
- Flight times and door to door times from the Home floor to all other floors entered in Building Data using the specified speed/acceleration/jerk combination.
- Distance travelled to reach rated acceleration.
- Time elapsed to reach rated acceleration.
- Speed at rated acceleration.
- Distance travelled to reach rated speed.
- Time elapsed to reach rated speed.
- Numerical values allowing you to plot the distance travelled, velocity, acceleration and jerk profiles for the specified trip.
Figure 34  Kinematics results
Motion

Motion is a tool to assist comparison between ideal and actual kinematics.

To measure actual kinematics you will need a stopwatch and a ride analyser, for example the EVA 625 Ride Analyser from Physical Measurement Technologies.

Our suggested measurement procedure is:

1. Start Ride Analyser and stopwatch at instant that doors start closing
2. Take lap time on stopwatch at when doors have fully closed
3. Take lap time on stopwatch when doors start opening
4. Halt stopwatch and Ride Analyser when doors are fully open

The measurements for distance, velocity, acceleration and jerk can then be exported from the Ride Analyser.

On the opening page of Motion (with the Ideal tab selected) you can enter nominal values of distance, velocity, and acceleration, jerk and start delay. Also enter your measured times for door open and door close.

The Type of curve is currently limited to systems where the acceleration and deceleration is the same. Systems with different acceleration and deceleration will be available to model in a future update.

![Image of Motion input of ideal kinematics parameters]

**Figure 35** Motion input of ideal kinematics parameters

Select the Measured tab and paste the measured values for time versus distance, velocity, acceleration and jerk.
**Figure 36**  Motion input of measured kinematics parameters

Select the **Next** button to see measured and ideal values plotted together.

**Figure 37**  Motion plot of Acceleration input of measured kinematics parameters
A control is provided to allow you to select which plot to view.

Distance, Velocity, Acceleration and Jerk plots are available.

To assist in lining up Ideal and Measured plots, further controls are provided to adjust Ideal parameters incrementally while viewing the plots together.

Once the Ideal and Measured plots are aligned, the Ideal measurements can be reviewed, and applied in Elevate simulations.

Select the Next button to see supplementary results and the data used to plot the Ideal curves.

There is some duplication between the Kinematics Tool and the Motion tool. In a future upgrade all functionality will be provided through the Motion tool and the Kinematics tools will be discontinued.

Count

Count is a new Elevate application to assist passenger traffic surveys. It replaces traditional clipboards and forms for lobby and in-car surveys. The observer who controls the software logs traffic. The output log recorded by the software can be processed manually. Alternatively, send the log files to Peters Research and we will convert it into an Elevate file for you (nominal processing fee). Count is part of Peters Research's strategy to improve the industry's understanding of traffic flows in buildings; if you allow us to process your traffic survey data we will use it to help us make recommendations about expected traffic in future publications.

Select Survey, Start from the Count menu.

First you must choose a survey output file (we strongly recommend that you use the default file name provided).

Then choose if you are doing an in car or lobby survey. Choose the car number or name of the Lobby level. The names of levels are as defined in Building Data when you start Count.
For a lobby survey, select **Passenger Enters** each time a passenger enters a car. Select **Passenger Exits** each time a passenger exits the car.

If there is a large load (e.g. hospital patient in wheelchair with carer), you can treat them as a single large passenger using the **Passenger Multiple**, i.e. set to 2.5 if the load is the equivalent of 2.5 regular passengers. Or you can use the parameter as a code, e.g. 1 for a single passenger, 2 for a passenger in wheelchair and carer, 3 for a passenger in a bed with porter, etc.

Note that if large queues form in the lobby and do not clear quickly (say 5 minutes), the measured traffic entering and exiting the car, will underestimate the peak arrival rate, which is normally processed in 5 minute periods. In this instance, it would be more representative (but more difficult) to log passengers joining the queue rather than entering the elevator.
The in car survey requires the observer to be standing or sitting in the elevator. Passenger entering and exiting the elevator are recorded in the same way as they are in the Lobby Survey.

The **Current floor** of the car is recorded with the **Car Data Up 1 floor** and **Down 1 floor** buttons. The names of levels are as defined in **Building Data** when you start **Count**.

There are individual buttons to record:

- **Parking Call**  When the elevator moves to a floor without a call being registered and the elevator doors do not open.
- **False Stop**    When the elevator answers a call, the doors open, but no passenger loads or unloads.
- **Refusal**      When the elevator answers a call, but the passenger does not load because the car is too full.

Free form comments can also be added to the log file using the **Add Comment** button.
Appendix A

This appendix details the traffic generator templates available in Passenger Data.
Constant traffic (% building pop per 5 mins)

*Elevate* will produce traffic based on the **Handling Capacity** specified between the **Start Time** and **End Time** entered.

Select the **arrival rate parameters** tab to define the traffic. The **Total Arrival Rate** is entered as a percentage of the building population per 5 minutes. Traffic is divided into three parts, % incoming, % outgoing and % interfloor.

Between the **Start Time** and **End Time**, random numbers determines the time each passenger arrives over the duration of the simulation.

4 Nb. 1000 kg elevators @ 2.50 m/s
Average of all runs

![Passenger Demand graph](image)

**Figure 41** Example Passenger Demand graph for Constant Traffic
Step profile

The traffic starts the simulation with the total 5 minutes handling capacity (as a percentage of the building population) at the Minimum level. The traffic increases in steps until it reaches the Maximum level. The Time between steps can be set, as well as the Step height.

Traffic is divided into three parts, % incoming, % outgoing and % interfloor.

4 Nb. 1000 kg elevators @ 2.50 m/s
Average of all runs

Total Passenger Activity
Incoming - solid line; Interfloor - dotted line; Outgoing - dashed line

Figure 42  Example Total Passenger Activity graph for step profile
Barney one hour up peak template

Elevate generates a one hour traffic profile which rises to the required peak **Handling Capacity** for 5 minutes, then drops again. Over the hour, 80% of the population are transported.

3 Nb. 1000 kg elevators @ 2.50 m/s  
Average of all runs

---

**Passenger Demand**  
**Total Up/Down Traffic - solid line above/below**

Figure 43  Example Passenger Demand graph for Barney one hour up peak template

For Dr Barney’s discussion of this template, please refer to **Elevate on the web**.
Barney one hour down peak template
Elevate generates a one hour traffic profile which rises to the required peak Handling Capacity for 5 minutes, then drops again. Over the hour, 80% of the population are transported.

3 Nb. 1000 kg elevators @ 2.50 m/s
Average of all runs

Figure 44  Example Passenger Demand graph for Barney one hour down peak template

For Dr Barney’s discussion of this template, please refer to Elevate on the web.
Barney one hour lunch template

Elevate generates a one hour traffic profile. The profile consists of four 5 minutes bursts of traffic at 1 times, 1\(\frac{1}{3}\) times, 1\(\frac{2}{3}\) times and 2 times the peak Handling Capacity. Between these four bursts of traffic, the traffic is maintained at on tenth of the specified peak Handling Capacity.

The traffic generated is divided into three parts, 40% incoming, 40% outgoing and 20% interfloor.

3 No. 1000 kg elevators @ 2.50 m/s
Average of all runs

**Total Passenger Activity**

Incoming - solid line; Interfloor - dotted line; Outgoing - dashed line

**Figure 45**  Example Passenger Demand graph for Barney one hour lunch template

For Dr Barney’s discussion of this template, please refer to Elevate on the web.
Barney one hour interfloor template

Elevate generates a one hour traffic profile based on a non-peak traffic situation. The total traffic Handling Capacity, as a percentage of the building population, is 2% for 20 minutes, then 3% for 20 minutes, then 4% for 20 minutes.

The traffic generated is divided into three parts, 10% incoming, 10% outgoing and 80% interfloor.

For Dr Barney’s discussion of this template, please refer to Elevate on the web.
Powell 2 hour lunch template

Elevate generates a 2 hour lunchtime traffic profile appropriate to the building population.

The population of individual floors is used to determine the distribution of arrival rates across the floors, and the attraction of each floor as a destination.

![Total Passenger Activity graph](image)

**Figure 47** Example Passenger Demand graph for Powell two hour lunch template
Powell 40 minute lunch template

Elevate generates a 40 minute lunchtime traffic profile appropriate to the building population.

3 Nb. 1000 kg elevators @ 2.50 m/s
Average of all runs

Figure 48  Example Passenger Demand graph for Powell 40 min lunch template
Siikonen full day template

Elevate generates an example all day traffic profile based on a sample multi-tenant office building in Paris. The traffic intensity data for this template was published by Dr Marja-Liisa Siikonen in *Elevator Technology 10, Proceedings of Elevcon 2000*.

3 Nb. 1000 kg elevators @ 2.50 m/s
Average of all runs

**Total Passenger Activity**

Incoming - solid line; Interfloor - dotted line; Outgoing - dashed line

Figure 49  Example Passenger Demand graph for Siikonen full day template

Siikonen full day (24 hour) template

This is the same as **Siikonen full day template** except that the simulation runs for the full 24 hours rather than between 07:00 hrs. and 20:00 hrs.
Strakosch full day template

Elevate generates an example all day traffic profile based on the traffic profile presented by Mr George Strakosch in The Vertical Transportation Handbook. The profile is based on the requirements of a commercial office building.

4 Nb. 1000 kg elevators @ 2.50 m/s
Average of all runs

Figure 50  Example Passenger Demand graph for Strakosch full day template

Strakosch full day (24 hour) template

This is the same as Strakosch full day template except that the simulation runs for the full 24 hours rather than between 08:00 hrs. and 18:00 hrs.
CIBSE full day template

Elevate generates an example all day traffic profile based on the traffic profile presented by Dr Gina Barney in *CIBSE Guide D, Transportation Systems in buildings*. The profile is based on the requirements of an office building.

4 Nb. 1000 kg elevators @ 2.50 m/s
Average of all runs

**Figure 51** Example Passenger Demand graph for CIBSE full day template

CIBSE full day (24 hour) template

This is the same as CIBSE full day template except that the simulation runs for the full 24 hours rather than between 07:00 hrs. and 20:00 hrs.
For examples, please select Elevate on the web from the Help menu, while connected to the Internet.